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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le navigateur

F11 ⌘+T
Ouvre l’onglet Styles et Formatage 
du volet latéral

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Formater les lignes

Dans LibreOffice, le terme de ligne s’applique à un segment indépendant (ligne), au bord extérieur 
d’une forme (bordure) ou à une flèche. Dans la plupart des cas, les propriétés d’une ligne que vous
pouvez modifier sont son style (continu, tirets, pointillés, invisible…), sa largeur et sa couleur.

! Attention

L’outil Largeur permet de définir l’épaisseur du trait. Ne pas confondre avec la largeur (lon-
gueur du trait) définissable dans la boîte de dialogue Position et taille.

Avec la barre d’outils Ligne et remplissage

Pour formater une ligne grâce à la barre d’outils Ligne et remplissage (Figure 1) :

 1) Assurez-vous que la ligne est sélectionnée dans le dessin.

 2) Sélectionnez le style de la ligne dans la liste déroulante Style de ligne.

 3) Définissez la largeur de la ligne, soit en la tapant dans la zone de saisie Largeur de ligne, 
soit en utilisant les flèches adjacentes vers le haut et vers le bas.

 4) Cliquez sur le petit triangle à droite de l’icône Couleur de ligne ( ) et choisissez une cou-
leur dans la palette qui s’ouvre alors.

 

Figure 1 : La barre d’outils Ligne et remplissage.
Les outils disponibles pour modifier les attributs sont encadrés en vert.

En haut les lignes, en bas le remplissage, les ombres et les extrémités de lignes.

Remarque

Quand le pointeur de la souris survole une icône ou un bouton d’une barre d’outils ou du vo-
let latéral, une infobulle vous indique son objet.

Avec le volet latéral

Pour formater une ligne grâce à la section Ligne de l’onglet Propriétés du volet latéral (Figure 2) :

 1) Assurez-vous que la ligne est sélectionnée dans le dessin.

 2) Ouvrez l’onglet Propriétés en cliquant sur son icône ( ) à droite de la fenêtre.

 3) Ouvrez la section Ligne en cliquant sur  à gauche de son titre.

 4) Sélectionnez dans les deux listes déroulantes le type de décoration (flèche, carré, cercle, 
etc.) à ajouter aux extrémités pour transformer la ligne en flèche. La liste de gauche s’ap-
plique au début de la ligne et celle de droite à sa fin.

 5) Choisissez le style de ligne dans la liste déroulante entre les deux précédentes.
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 6) Choisissez la largeur de la ligne parmi celles proposées dans la liste déroulante Largeur ou 
définissez-la dans la zone de saisie en bas de cette liste.

 7) Cliquez sur  à droite de l’icône Couleur pour faire votre choix dans la palette qui s’ouvre.

 8) Désélectionnez la ligne pour enregistrer vos modifications.

Figure 2 : la section Ligne dans l’onglet Propriétés du volet latéral.

Avec la boîte de dialogue Ligne

Figure 3 : la boîte de dialogue Ligne

Si vous désirez modifier totalement l’apparence d’une ligne, vous devez utiliser la boîte de dia-
logue Ligne.
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 1) Assurez-vous que la ligne est sélectionnée dans le dessin.

 2) Sélectionnez Ligne dans le menu Format ou dans le menu contextuel ouvert par un clic 
droit sur la ligne, ou cliquez sur le bouton Plus d’options ( ) à droite du titre du panneau 
Ligne dans le volet latéral. La boîte de dialogue Ligne s’ouvre (Figure 3). Cette boîte de dia-
logue est constituée de quatre onglets : Ligne, Ombre, Styles de ligne et Styles de flèche qui 
sont présentés dans les sections suivantes.

 3) Une fois les modifications réalisées, cliquez sur OK pour refermer la boîte de dialogue et en-
registrer les changements. La zone d’aperçu en bas de la boîte de dialogue vous montre les 
effets sur la ligne des choix que vous effectuez.

Onglet Ligne

L’onglet Ligne de la boîte de dialogue Ligne (Figure 3) est l’endroit où vous pouvez définir les para-
mètres de base de la ligne. Il est partagé en trois sections.

Propriétés de ligne
Cette section vous permet de définir les paramètres suivants :

– Style : sélectionnez un style de ligne dans la liste déroulante ;

– Couleur : sélectionnez une couleur prédéfinie dans la palette ou créez une couleur per-
sonnalisée ;

– Largeur : tapez la largeur de la ligne dans la boîte de saisie ou utilisez les boutons fléchés
adjacents. L’unité de mesure par défaut est celle indiquée dans Outils > Options > 
LibreOffice Draw > Général, mais vous pouvez saisir une autre unité. Si cette valeur est 
nulle, la ligne résultante a une largeur minimale d’un pixel.

– Transparence : définissez la transparence de la ligne. La Figure 4 montre l’effet de diffé-
rents pourcentages de transparence de lignes placées sur un objet.

Figure 4 : Transparence d’une ligne.
De gauche à droite  : 0 %, 25 %, 50 % et 75 %.

Styles de flèches
Les paramètres de la section Styles de flèche ne s’appliquent qu’aux lignes individuelles et 
n’ont aucun effet sur les lignes qui constituent la bordure d’une forme.

– Style de départ et Style de fin : choisissez le style de terminaison en début et en fin de 
ligne dans les listes déroulantes.

– Largeur : spécifiez la largeur de l’élément terminal choisi. L’unité de mesure par défaut est
celle indiquée dans Outils > Options > LibreOffice Draw > Général, mais vous pouvez 
saisir une autre unité. Si cette valeur est nulle, la flèche disparaîtra.

– Centre : cochez cette option pour déplacer le centre de l’élément de terminaison à l’extré-
mité de la ligne (Figure 5).
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Figure 5 : Placement des terminaisons de lignes.
En haut  : par défaut  ; en bas : option centre cochée.

– Synchroniser les extrémités : cochez cette option si vous voulez deux extrémités iden-
tiques.

! Attention

Le simple fait de cocher l’option Synchroniser les extrémités ne va
pas rendre identique les deux extrémités de la ligne. Il faut que
vous modifiiez un attribut pour que ses valeurs soient identiques
pour le début et la fin de la ligne.

Pour choisir rapidement les terminaisons d’une ligne sélectionnée, cli-
quez sur l’icône Style de flèche ( ) dans la barre d’outils Ligne et rem-
plissage pour ouvrir la palette Extrémités de flèches (Figure 6) où vous
pouvez faire votre choix parmi les terminaisons prédéfinies pour le début
(à gauche dans la palette) et la fin (à droite dans la palette) de la ligne.

Remarque

Les terminaisons ne sont applicables qu’aux lignes individuelles et
n’ont aucun effet sur les bordures des objets.

Styles d’angle et de coiffe
Les styles d’angle et de coiffe déterminent l’apparence de la jonction entre deux segments. 
Pour constater la différence entre les styles, dessinez une ligne épaisse et observez le chan-
gement dans l’aperçu.

– Style d’angle : sélectionnez la forme qui sera appliquée aux sommets de la ligne. Si les 
deux parties forment un angle aigu, le style En onglet sera remplacé par un style Biseau-
té.

Figure 7 : De gauche à droite, style d’angle
Arrondi, - aucun -, En onglet, Biseauté.

– Style de coiffe : choisissez la forme des extrémités de la ligne. Le style de coiffe choisi 
s’applique aussi aux tirets.
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Figure 8 : Styles de coiffe. De haut en bas, Plat, Rond et Carré.

Onglet Ombre

L’onglet Ombre (Figure 9) est l’endroit où vous pouvez ajouter et formater une ombre à la ligne sé-
lectionnée. Le contenu de cet onglet est identique à celui s’appliquant aux objets et est décrit dans 
« Ombre » page 27.

Figure 9 : L’onglet Ombre de la boîte de dialogue Ligne

Vous pouvez appliquer rapidement une ombre à la ligne sélectionnée en utilisant l’icône Ombre (
) de la barre d’outils Ligne et remplissage. Cependant, l’ombre appliquée ne sera que celle défi-

nie par le style graphique par défaut.

Onglet Styles de ligne

L’onglet Styles de ligne (Figure 10) est l’endroit où vous allez pouvoir créer de nouveaux styles de 
ligne et charger des styles préalablement enregistrés. Il est préférable de créer de nouveaux styles
plutôt que de modifier des styles prédéfinis. Un exemple du style de ligne sélectionné ou créé est 
affiché en bas de la boîte de dialogue.

Créer un style de ligne

Pour créer un style de ligne à partir de cet onglet :

 1) Ouvrez la boîte de dialogue Ligne en sélectionnant Ligne dans le menu Format ou dans le 
menu contextuel, ou en cliquant sur le bouton Ligne ( ) dans la barre d’outils Ligne et for-
matage.

 2) Ouvrez l’onglet Styles de ligne (Figure 10).

 3) Choisissez dans la liste déroulante Style de ligne un style proche de celui que vous voulez 
créer.
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 4) Cliquez sur Ajouter. Dans la boîte de dialogue Nom qui s’ouvre, saisissez le nom du nou-
veau style de ligne et cliquez sur OK.

 5) Définissez le nouveau style. Commencez par choisir le type de composant de la ligne (Point 
ou Tiret). Vous pouvez alterner ces composants en choisissant deux types différents dans 
les deux zones du type de ligne.

 6) Saisissez le nombre et la longueur de chacun des composants de la ligne. La longueur n’est 
pas disponible pour un composant de type Point.

 7) Saisissez l’espacement entre les différents composants.

 8) Vous pouvez cocher l’option Adapter à la largeur de la ligne.

Figure 10 : L’onglet Styles de ligne de la boîte de dialogue Ligne

Le nouveau style de ligne ainsi créé n’est disponible que dans le document en cours. Si vous vou-
lez l’utiliser dans d’autres documents, cliquez sur l’icône Enregistrer les styles de lignes ( ) et 
saisissez un nom de fichier dans la boîte de dialogue Enregistrer sous qui s’ouvre. Le fichier a une 
extension .sod et comprend la liste active des styles de ligne.

Pour utiliser des styles de ligne préalablement enregistrés, cliquez sur l’icône Charger les styles 
de ligne ( ) et sélectionnez un fichier dans la boîte de dialogue Ouvrir qui s’ouvre. Cliquez sur 
Ouvrir pour charger la liste des styles dans votre document.

Si nécessaire, cliquez sur le bouton Modifier pour modifier le nom du style de ligne.

Supprimer des styles de ligne

Pour supprimer un style de ligne :

 1) Ouvrez la boîte de dialogue Ligne en sélectionnant Ligne dans le menu Format ou dans le 
menu contextuel, ou en cliquant sur le bouton Ligne ( ) dans la barre d’outils Ligne et for-
matage.
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 2) Ouvrez l’onglet Styles de ligne (Figure 10).

 3) Sélectionnez le style que vous voulez supprimer dans la liste déroulante Styles de ligne.

 4) Cliquez sur le bouton Supprimer et confirmez la suppression en cliquant sur Oui dans la 
boîte de dialogue qui s’ouvre.

 5) Cliquez sur OK pour refermer la boîte de dialogue Ligne et enregistrer les modifications 
faites.

Remarque

Quand vous supprimez un style de ligne, vérifiez qu’il n’est pas utilisé dans un autre docu-
ment.

Onglet styles de flèche

L’onglet Styles de flèche (Figure 11) est l’endroit où vous allez pouvoir créer et modifier des styles 
de flèche et charger des styles préalablement enregistrés.

Figure 11 : L’onglet Styles de flèche de la boîte de dialogue Ligne

Créer un style de flèche

Pour créer un style de flèche à partir de cet onglet :

 1) Dessinez tout d’abord la courbe que vous voulez utiliser comme pointe de flèche, ou créez 
une forme et convertissez-la en courbe. Le sommet de la forme doit se trouver vers le haut, 
comme sur la Figure 12, parce qu’il va devenir la pointe de la flèche.
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Figure 12 : utiliser une courbe comme pointe de flèche

 2) Sélectionnez la forme et, si nécessaire, convertissez-la en courbe en choisissant Convertir 
> En courbe dans le menu Forme ou le menu contextuel. Si la forme est déjà une courbe, la
commande ne sera pas disponible.

Remarque

La pointe de flèche doit être une courbe, c’est-à-dire quelque chose que vous pouvez tracer 
sans lever le crayon du papier. Par exemple, une étoile peut être une courbe, mais une fri-
mousse ne peut pas l’être. Le bouton Ajouter ne sera pas actif si l’objet sélectionné n’est 
pas du bon type.

 3) Ouvrez la boîte de dialogue Ligne en sélectionnant Ligne dans le menu Format ou le menu 
contextuel, ou en cliquant sur le bouton Ligne ( ) dans la barre d’outils Ligne et formatage.

 4) Dans l’onglet Styles de flèche, cliquez sur le bouton Ajouter, saisissez le nom du nouveau 
style de flèche et cliquez sur OK. Le nouveau style de flèche va s’afficher dans l’aperçu en 
bas de la boîte de dialogue.

Vous pouvez alors choisir ce style de flèche en bas de la liste déroulante.

Le nouveau style de flèche ainsi créé n’est disponible que dans le document en cours. Si vous 
voulez l’utiliser dans d’autres documents, cliquez sur l’icône Enregistrer les styles de flèche ( )
et saisissez un nom de fichier dans la boîte de dialogue Enregistrer sous qui s’ouvre. Le fichier a 
une extension .soe et comprend la liste active des styles de flèche.

Pour utiliser des styles de flèche préalablement enregistrés, cliquez sur l’icône Charger les styles 
de flèche ( ) et sélectionnez un fichier dans la boîte de dialogue Ouvrir qui s’ouvre. Cliquez sur 
Ouvrir pour charger la liste des styles dans votre document.

Si nécessaire, cliquez sur le bouton Modifier pour modifier le nom du style de flèche.

Supprimer des styles de flèche

Pour supprimer un style de flèche :

 1) Ouvrez la boîte de dialogue Ligne en sélectionnant Ligne dans le menu Format ou dans le 
menu contextuel, ou en cliquant sur le bouton Ligne ( ) dans la barre d’outils Ligne et for-
matage.

 2) Ouvrez l’onglet Styles de flèche (Figure 10).

 3) Sélectionnez le style que vous voulez supprimer dans la liste déroulante Styles de flèche.

 4) Cliquez sur le bouton Supprimer et confirmez la suppression en cliquant sur Oui dans la 
boîte de dialogue qui s’ouvre.

 5) Cliquez sur OK pour refermer la boîte de dialogue Ligne et enregistrer les modifications 
faites.
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Remarque

Quand vous supprimez un style de flèche, vérifiez qu’il n’est pas utilisé dans un autre docu-
ment.

Formater le remplissage

Le terme de remplissage fait référence à l’intérieur d’un objet, qui peut être d’une couleur uniforme,
en dégradé, avec un motif ou des hachures, ou constitué d’une image bitmap (Figure 13). Le rem-
plissage d’un objet peut être partiellement ou totalement transparent et projeter une ombre.

Couleur

Dégradé

Hachures

Bitmap

Motif

Figure 13 : Exemples de types de remplissage

Avec la barre d’outils Ligne et remplissage

La barre d’outils Ligne et remplissage (Figure 1, page 1) contient les outils le plus habituellement 
utilisés pour formater des objets. Si elle n’est pas visible, sélectionnez Affichage > Barres d’ou-
tils > Ligne et remplissage dans la barre de menu. Pour formater le remplissage d’un objet :

 1) Sélectionnez tout d’abord un objet (les poignées de sélection deviennent visibles).

 2) Cliquez sur le contrôle Style de remplissage et choisissez ensuite un des types de remplis-
sage (Figure 14).

Figure 14 : Les styles de remplissage

 3) Cliquez ensuite sur le contrôle situé à sa droite pour choisir une des options disponibles 
dans la liste déroulante. Pour plus d’informations sur les types de remplissage, voir « Avec 
la boîte de dialogue Remplissage », page 11.

– Options de couleur sur la Figure 15.

– Options de dégradés sur la Figure 16.

– Options de hachures sur la Figure 17.
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– Options de bitmaps sur la Figure 18.

– Options de motifs, voir l’option Remplir dans la section Zone de l’onglet Propriétés du vo-
let latéral (Figure 19) ou la section Motif de l’onglet Remplissage de la boîte de dialogue 
Remplissage (Figure 24, page 15).

 4) Désélectionnez l’objet pour enregistrer les modifications (en appuyant sur la touche Échap 
ou en cliquant sur un emplacement libre de l’espace de travail).

Figure 15 : Couleurs de remplissage

Figure 16 : Styles de dégradés

Figure 17 : Styles de hachures

Figure 18 : Types de Bitmaps

Avec le volet latéral

Pour formater rapidement l’intérieur d’un objet avec le volet latéral (Figure 19) :

 1) Assurez-vous que la ligne est sélectionnée dans le dessin.
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 2) Ouvrez l’onglet Propriétés en cliquant sur son icône ( ) à droite de la fenêtre puis la section
Zone en cliquant sur  à gauche de son titre.

 3) Utilisez les options des listes déroulantes Remplir et Transparence pour formater le remplis-
sage de l’objet. Pour plus d’informations sur les choix possibles, voyez « Avec la boîte de 
dialogue Remplissage », page 11.

 4) Désélectionnez la ligne pour enregistrer vos modifications.

Figure 19 : La section Zone de l’onglet Propriétés du volet latéral.

Avec la boîte de dialogue Remplissage

Si vous avez besoin de régler plus finement les attributs de remplissage d’un objet ou de créer les 
vôtres, vous pouvez le faire dans la boîte de dialogue Remplissage (Figure 20). Pour y accéder,

 1) sélectionnez l’objet que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage qui vous permet d’appliquer des remplissages prédéfinis, four-
nis par LibreOffice ou créés par vous ou d’autres utilisateurs. Voir « Créer de nouveaux 
remplissages », page 16.

 4) Choisissez le type de remplissage (Aucun, Couleur, Dégradé, Bitmap, Motif et Hachures) en 
cliquant sur un des boutons en haut de l’onglet.

 5) Sélectionnez un style de remplissage parmi les options qui sont présentées. Elles dépendent
du type de remplissage précédemment sélectionné.

 6) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer les modifications. Le rem-
plissage choisi apparaît dans l’objet sélectionné.

Types de remplissages

Aucun

Si vous cliquez sur le bouton Aucun (Figure 20), vous obtenez un objet vide.
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Couleur

 1) Cliquez sur Couleur (Figure 20) pour faire apparaître les contrôles de réglage de la couleur.

 2) Sélectionnez une palette dans la liste déroulante Palette puis une couleur parmi celles qui 
sont proposées. Ce sont toutes des couleurs unies.

Figure 20 : L’onglet Couleur de la boîte de dialogue Remplissage

 3) Le rectangle de la section Active vous montre la couleur de remplissage courante de l’objet 
sélectionné. Après le choix d’une nouvelle couleur, le rectangle de la section Nouveau re-
flète votre sélection.

 4) Vous pouvez aussi saisir les valeurs des composantes Rouge, Verte et Bleue ou la valeur 
hexadécimale de la couleur dans les contrôles de saisie de la section Nouveau.

 5) Vous avez encore la possibilité de cliquer sur Choisir une couleur pour ouvrir la boîte de 
dialogue de même nom (Figure 21). Dans celle-ci, vous pouvez sélectionner une couleur en 
cliquant dans la surface colorée en haut à gauche, changer de teinte grâce à la bande verti-
cale à sa droite ou saisir les composantes de la couleur dans les systèmes RVB (Rouge/
Vert/Bleu), HSB (Hue/Saturation/Brightness : Teinte/Saturation/Luminosité) ou CJMN (Cyan/
Jaune/Magenta/Noir).

 6) Si vous souhaitez réutiliser une couleur dont vous vous êtes déjà servi, choisissez-la parmi 
les Couleurs récemment utilisées.

 7) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer vos modifications. La cou-
leur choisie apparaît dans l’objet sélectionné.
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Figure 21 : La boîte de dialogue Choisir une couleur

Dégradé

 1) Cliquez sur Dégradé (Figure 22) pour faire apparaître les contrôles de réglage des dégra-
dés.

Figure 22 : L’onglet Dégradé de la boîte de dialogue Remplissage
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 2) Sélectionnez un dégradé dans la liste à gauche de la boîte de dialogue. Il apparaît dans la 
zone Aperçu à droite.

 3) Si vous décochez l’option Automatique, vous pouvez choisir le nombre de pas (Incrément) 
du dégradé, puis sélectionnez le Type (Linéaire, Axial, Radial, Ellipsoïde, Quadratique ou 
Carré), l’Angle, la Bordure et la Couleur d’origine et de destination.

 4) Cliquez sur OK pour que le dégradé choisi devienne le dégradé de remplissage de l’objet sé-
lectionné.

Bitmap

 1) Cliquez sur Bitmap (Figure 23) pour faire apparaître les contrôles de réglage des images bit-
map.

Figure 23 : L’onglet Bitmap de la boîte de dialogue Remplissage

 2) Sélectionnez une image dans liste Bitmap à gauche de la boîte de dialogue. Elle apparaît 
dans zone Aperçu à droite.

 3) Pour paramétrer l’image selon vos besoins, modifiez les valeurs des champs Style, Taille, 
Position, Décalage X et Y et Décalage dans la section Options.

 4) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer vos modifications. L’image 
bitmap choisie apparaît dans l’objet sélectionné.

Motif

 1) Cliquez sur Motif (Figure 24) pour faire apparaître les contrôles de réglage des motifs.
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Figure 24 : L’onglet Motif de la boîte de dialogue Remplissage

 2) Sélectionnez un style dans liste Motif à gauche de la boîte de dialogue. Elle apparaît dans 
zone Aperçu à droite.

 3) Pour paramétrer le motif selon vos besoins, modifiez-le dans l’Éditeur de motif puis choisis-
sez une Couleur de premier plan et une Couleur d’arrière-plan dans les contrôles de la sec-
tion Options.

 4) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer vos modifications. Le motif 
choisi apparaît dans l’objet sélectionné.

Hachures

 1) Cliquez sur Hachures (Figure 25) pour faire apparaître les contrôles de réglage des styles 
de hachures.

 2) Sélectionnez un style dans liste Hachures à gauche de la boîte de dialogue. Elle apparaît 
dans zone Aperçu à droite.

 3) Pour paramétrer les hachures selon vos besoins, saisissez un nouvel Espacement, l’Angle 
d’inclinaison des lignes, le Type et la Couleur de ligne ainsi que la Couleur d’arrière-plan 
dans les contrôles de la section Options.

 4) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer vos modifications. Le motif 
choisi apparaît dans l’objet sélectionné.
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Figure 25 : L’onglet Hachures de la boîte de dialogue Remplissage

Créer de nouveaux remplissages

Couleurs personnalisées

Créer des couleurs à l’aide de la boîte de dialogue Remplissage

Grâce à la boîte de dialogue Remplissage (Figure 20, page 12), vous pouvez créer une nouvelle 
couleur par une combinaison des trois couleurs primaires rouge, vert et bleu (notation RVB). Pro-
cédez de la manière suivante :

 1) Sélectionnez l’objet que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Couleur pour ouvrir la page correspon-
dante.

 4) Spécifiez les valeurs de rouge (R), vert (V) et bleu (B) entre 0 et 255 dans les contrôles de 
saisie de la section Nouvelle pour créer la nouvelle couleur.

 5) Cliquez sur le bouton Ajouter pour ouvrir la boîte de dialogue Nom (Figure 26) et saisissez 
un nom pour la nouvelle couleur.
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Figure 26 : La boîte de dialogue Nom d’une couleur

 6) Cliquez sur OK pour refermer la boîte de dialogue Nom et ajouter la nouvelle couleur à la pa-
lette Personnalisé.

 7) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue Remplis-
sage. La nouvelle couleur remplit l’objet sélectionné.

Créer des couleurs à l’aide de la boîte de dialogue Choisir une couleur

Il est possible de créer une nouvelle couleur en utilisant la boîte de dialogue Choisir une couleur 
de la manière suivante :

 1) Sélectionnez l’objet que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Couleur pour ouvrir la page correspon-
dante (Figure 20, page 12).

 4) Cliquez sur le bouton Choisir une couleur pour ouvrir la boîte de dialogue de même nom 
(Figure 21, page 13).

 5) Utilisez une des méthodes suivantes pour créer la nouvelle couleur. Un aperçu de la nou-
velle couleur apparaît dans la moitié gauche du rectangle en bas à gauche de la boîte de 
dialogue, où vous pouvez la comparer à la couleur initiale (moitié droite du rectangle) ;

– Sélectionnez une teinte en cliquant dans le rectangle vertical multicolore au centre de la 
boîte de dialogue. Cliquez et déplacez le pointeur de la souris dans le grand rectangle en 
haut à gauche de la boîte de dialogue pour choisir une nuance.

– Saisissez les valeurs (entre 0 et 255) de rouge, vert et bleu dans les contrôles de saisie 
correspondants en haut à droite de la boîte de dialogue.

– Saisissez la valeur hexadécimale de la couleur dans le système RVB dans le contrôle 
Hexa sous les précédents.

– Saisissez les valeurs de la teinte (entre 0 et 360°), de la saturation et de la luminosité 
(entre 0 et 100 %) dans les contrôles de saisie de la section HSB.

– Saisissez les valeurs (entre 0 et 100 %) de cyan, magenta, jaune et de noir (le champ 
Touche1 ou Valeur2 contrôle la couleur noire) dans les contrôles de saisie de la section 
CMJN.

 6) Cliquez sur OK pour fermer la boîte de dialogue Choisir une couleur.

1 LibreOffice 6.4.5
2 LibreOffice 6.4.6
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 7) Cliquez sur le bouton Ajouter pour ouvrir la boîte de dialogue Nom (Figure 26) et saisissez 
un nom pour la nouvelle couleur.

 8) Cliquez sur OK pour refermer la boîte de dialogue Nom et ajouter la nouvelle couleur à la 
Palette personnalisée.

 9) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue Remplis-
sage. La nouvelle couleur remplit l’objet sélectionné.

Supprimer des couleurs personnalisées

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Couleur pour ouvrir la page correspon-
dante (Figure 20, page 12).

 3) Sélectionnez personnalisé dans la liste déroulante Palette.

 4) Choisissez la couleur que vous voulez supprimer dans la palette et cliquez sur le bouton 
Supprimer. La couleur est supprimée de la palette sans demande de confirmation.

 5) Refermez la boîte de dialogue en cliquant sur OK (pour appliquer la couleur visible dans la 
section Nouvelle à l’objet sélectionné) ou sur Annuler (pour seulement enregistrer la sup-
pression de la couleur).

Remarque

Il est recommandé de ne supprimer que des couleurs que vous avez créées dans la Palette 
personnalisée. Supprimer des couleurs dans les palettes standards fournies avec Libre-
Office peut provoquer des problèmes dans les documents qui utilisent une des couleurs 
standards.

Dégradés personnalisés

Vous pouvez créer des dégradés personnalisés, ou modifier des dégradés existants, dans l’onglet 
Dégradés de la boîte de dialogue Remplissage. Plusieurs types de dégradés sont prédéfinis et, 
dans la plupart des cas, il suffira de modifier les couleurs pour obtenir le résultat désiré.

Remarque

Il est recommandé, même si vous souhaitez seulement modifier les deux couleurs, de 
conserver les dégradés prédéfinis tels quels et de les utiliser plutôt comme point de départ 
pour créer de nouveaux dégradés, plutôt que de les modifier. En effet, les dégradés prédéfi-
nis peuvent avoir été utilisés dans d’autres objets du dessin ou d’un autre document.

Créer de nouveaux dégradés

 1) Sélectionnez l’objet que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.
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 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Dégradé pour ouvrir la page corres-
pondante (Figure 22, page 13).

 4) Dans la section Options,

– sélectionnez les couleurs d’origine et de destination dans les palettes qui s’ouvrent en cli-
quant sur les boutons,

– choisissez le type de dégradé dans la liste déroulante Type : Linéaire, Axial, Radial, Ellip-
soïde, Quadratique ou Carré. La zone d’Aperçu à droite de la boîte de dialogue montre 
l’aspect du gradient choisi (Figure 27),

Linéaire Axial Radial

Ellipsoïde Quadratique Carré

Figure 27 : Types de dégradés

– paramétrez les propriétés selon vos goûts. Leurs fonctions sont résumées dans le Ta-
bleau 1. Selon le type de dégradé choisi, toutes ne sont pas accessibles,

– si vous décochez l’option Automatique, vous pouvez choisir le nombre de pas (Incrément)
du dégradé (Figure 28),

Figure 28 : Dégradé automatique (64 pas) à gauche et de 4 pas à droite

 5) Cliquez sur le bouton Ajouter pour ouvrir la boîte de dialogue Nom (Figure 26) et saisissez 
un nom pour le nouveau dégradé. Cliquez sur OK pour refermer la boîte de dialogue Nom.

 6) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue Remplis-
sage.

Tableau 1 : Propriétés du dégradé

Propriété Signification

Centre X, 
Centre Y

Pour les types Radial, Ellipsoïde, Carré et Quadratique, positionne le centre du 
dégradé sur l’axe X ou l’axe Y, en pourcentage de la largeur de l’objet.
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Propriété Signification

Angle Pour tous les types de dégradés, spécifie l’angle de l’axe du dégradé par rapport
à l’axe horizontal.

Bordure Spécifie le pourcentage de l’axe du dégradé à partir duquel le dégradé com-
mence (0 % : au début de l’axe ; 100 % : à la fin de l’axe).

Couleur d’ori-
gine

Indique la couleur de départ du dégradé. Le pourcentage correspond à l’intensité
de la couleur, de 0 % pour le noir à 100 % pour l’intensité maximale.

Couleur de 
destination

Indique la couleur d’arrivée du dégradé. Le pourcentage correspond à l’intensité 
de la couleur, de 0 % pour le noir à 100 % pour l’intensité maximale.

Modifier des dégradés

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Dégradé pour ouvrir la page corres-
pondante (Figure 22, page 13).

 3) Sélectionnez un dégradé que vous avez créé et ajouté à la liste affichée dans l’onglet Dégra-
dé.

 4) Saisissez les nouvelles valeurs des propriétés du dégradé que vous souhaitez modifier. Re-
portez-vous au Tableau 1 pour plus d’informations sur ces propriétés. Selon le type de dé-
gradé choisi, certaines pourront ne pas être accessibles.

 5) Cliquez sur le bouton Modifier pour enregistrer vos changements. Aucune confirmation ne 
vous est demandée quand vous modifiez un dégradé.

 6) Refermez la boîte de dialogue en cliquant sur OK (pour appliquer le dégradé visible dans la 
section Aperçu à l’objet sélectionné) ou sur Annuler (pour seulement enregistrer la suppres-
sion du dégradé).

Supprimer des dégradés

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Dégradé pour ouvrir la page corres-
pondante (Figure 22, page 13).

 3) Faites un clic droit sur le dégradé que vous voulez supprimer et choisissez Supprimer dans 
le menu contextuel. Confirmez en cliquant sur Oui dans la boîte de dialogue qui s’ouvre 
alors.

 4) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les modifica-
tions.
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Remarque

Il est recommandé de ne supprimer que des dégradés que vous avez créés. Supprimer des 
dégradés fournis avec LibreOffice peut provoquer des problèmes dans les documents qui 
utilisent un de ceux-ci.

Contrôle interactif des dégradés

LibreOffice offre un contrôle interactif des dégradés utilisable de la façon suivante.

 1) Sélectionnez un objet qui utilise le dégradé comme remplissage.

 2) Ouvrez la palette Transformations dans la barre d’outils Standard ou Ligne et remplissage 
(Figure 29) et cliquez sur l’icône Outil dégradé interactif ( ). Vous pouvez aussi sélection-
ner Forme > Transformations > Outil dégradé dans la barre de menu.

Figure 29 : La palette Transformations dans la barre d’outils Ligne et remplissage

 3) Une ligne en tirets terminée par deux carrés colorés s’affiche. Les couleurs des carrés sont 
celles des champs Couleur d’origine et Couleur de destination du dégradé (Figure 30).

Figure 30 : L’outil Dégradé interactif en action

 4) Les propriétés que vous pouvez ajuster dépendent du type de dégradé sélectionné.

– Linéaire : déplacez le carré correspondant à la Couleur d’origine pour modifier le point de 
départ du dégradé. Déplacez le carré correspondant à la Couleur de destination pour mo-
difier l’orientation du dégradé (valeur du champ Angle).

– Axial : déplacez le carré correspondant à la Couleur de destination pour modifier à la fois 
l’orientation (valeur du champ Angle) et le point de départ du dégradé (valeur du champ 
Bordure).

– Radial : déplacez le carré correspondant à la Couleur d’origine pour modifier la valeur du 
champ Bordure et définir le rayon du cercle du dégradé. Déplacez le carré correspondant 
à la Couleur de destination pour changer le point où le dégradé s’achève (valeurs des 
champs Centre X et Y)

– Ellipsoïde : déplacez le carré correspondant à la Couleur d’origine pour modifier la valeur 
du champ Bordure et définir la taille du dégradé, et pour modifier l’orientation de l’axe du 
dégradé (valeur du champ Angle). Déplacez le carré correspondant à la Couleur de desti-
nation pour changer le centre du dégradé (valeurs des champs Centre X et Y).
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– Quadratique et carré : déplacez le carré correspondant à la Couleur d’origine pour modi-
fier la valeur du champ Bordure et définir la taille du dégradé, et pour modifier l’orientation
de l’axe du dégradé (valeur du champ Angle). Déplacez le carré correspondant à la Cou-
leur de destination pour changer le centre du dégradé (valeurs des champs Centre X et 
Y).

Images Bitmap

Modifier les images

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Bitmap pour ouvrir la page correspon-
dante (Figure 23, page 14).

 4) Sélectionnez, dans la section Bitmap, l’image que vous voulez utiliser et modifier. Notez que
tous les bitmaps importés sont aussi disponibles.

 5) Dans la section Options, paramétrez le Style, la Taille, la Position et le Décalage. Voyez le
Tableau 2 pour plus d’informations sur ces propriétés. La meilleure façon de bien les com-
prendre est de les utiliser. La Figure 31 montre des exemples de remplissage par un bitmap 
avec les propriétés utilisées.

 6) Cliquez sur OK pour enregistrer vos modifications et fermer la boîte de dialogue Remplis-
sage.

Image originale

Largeur et Hauteur proportion-
nelles 25 %
Position en haut à gauche
Pas de décalage.

Largeur et Hauteur proportion-
nelles 25 %
Position en haut à droite
Décalage Ligne 50 %

Figure 31 : Exemples de remplissage par une image bitmap
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Tableau 2 : Propriétés du motif

Propriété Signification

Style • Position / taille personnalisée : quand cette option est sélectionnée, la po-
sition et la taille de l’image peuvent être déterminées.

• Mosaïque : quand cette option est sélectionnée, l’image recouvre la sur-
face comme des carreaux dont la taille est définie par les champs Largeur 
et Hauteur.

• Étiré : quand cette option est sélectionnée, l’image est étirée pour recouvrir
toute la surface.

Largeur
Hauteur

Définissent les dimensions de l’image, soit en unités de longueur, soit en pour-
centage des dimensions de la surface à remplir si Échelle est cochée (100 % : 
toute la largeur ou toute la hauteur ; 50 % la moitié de la largeur ou de la hau-
teur).

Échelle Si cette option est cochée, les dimensions de l’image sont données en pourcen-
tages de celles de la surface à remplir. Sinon, ce sont les dimensions réelles de 
l’image qui sera utilisée.

Position Cette option définit le point d’ancrage de l’image dans la surface à remplir.

Décalage X
Décalage Y

Définissent le décalage horizontal et vertical de l’image, par rapport au point 
d’ancrage, en pourcentage de ses dimensions. 50 % signifie que le milieu de 
l’image sera placé au point d’ancrage pour commencer la mosaïque.

Décalage Définit le décalage des lignes ou des colonnes en pourcentage pour que deux 
lignes ou colonnes consécutives ne soient pas alignées.

Importer des images

Pour importer des images matricielles (bitmaps) créées par un autre programme :

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez importer.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Bitmap pour ouvrir la page correspon-
dante (Figure 23, page 14).

 4) Cliquez sur le bouton Ajouter / Importer. Une boîte de dialogue d’ouverture de fichier, nom-
mée Ajouter une image, apparaît.

 5) Recherchez l’image que vous voulez importer, sélectionnez-la et cliquez sur Ouvrir.

 6) Saisissez un nom pour l’image dans la boîte de dialogue Nom puis cliquez sur OK pour la re-
fermer.

 7) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les modifica-
tions.
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Supprimer des images

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Bitmap pour ouvrir la page correspon-
dante (Figure 23, page 14).

 3) Faites un clic droit sur l’image que vous voulez supprimer et choisissez Supprimer dans le 
menu contextuel. Confirmez en cliquant sur Oui dans la boîte de dialogue qui s’ouvre alors.

 4) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les modifica-
tions.

Remarque

Il est recommandé de ne supprimer que des images que vous avez importées. Supprimer 
des images fournies avec LibreOffice peut provoquer des problèmes dans les documents 
qui utilisent une de celles-ci.

Motifs

Créer ou éditer un motif

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez créer ou modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Motif pour ouvrir la page correspon-
dante (Figure 24, page 15).

 4) Dans la section Options, choisissez les couleurs que vous voulez utiliser pour le premier 
plan et l’arrière-plan dans les palettes ouvertes en cliquant sur les boutons correspondants 
(Figure 32).

 5) Dans l’Éditeur de motif, cliquez dans les carrés qui représentent les pixels du motif, avec le 
bouton gauche pour leur donner la couleur de premier plan et avec le bouton droit pour leur 
donner la couleur d’arrière-plan. La zone Aperçu vous permet de vérifier l’effet obtenu.

 6) Si vous avez créé un nouveau motif, cliquez sur le bouton Ajouter pour ouvrir la boîte de 
dialogue Nom. Saisissez le nom du nouveau motif puis cliquez sur OK pour refermer la boîte
de dialogue.

 7) Si vous avez modifié un motif existant, cliquez sur Modifier pour enregistrer les change-
ments. Aucune confirmation ne vous est demandée avant l’enregistrement.

 8) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue Remplis-
sage.
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Figure 32 : Créer ou modifier un motif

Supprimer des motifs

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Motif pour ouvrir la page correspon-
dante (Figure 24, page 15).

 3) Faites un clic droit sur le motif que vous voulez supprimer et choisissez Supprimer dans le 
menu contextuel. Confirmez en cliquant sur Oui dans la boîte de dialogue qui s’ouvre alors.

 4) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les modifica-
tions.

Remarque

Il est recommandé de ne supprimer que des motifs que vous avez créés. Supprimer des 
motifs fournis avec LibreOffice peut provoquer des problèmes dans les documents qui uti-
lisent un de ceux-ci.

Hachures personnalisées

Vous pouvez créer des hachures personnalisées, ou modifier des hachures existantes, dans l’on-
glet Hachure de la boîte de dialogue Remplissage. Comme pour les dégradés et les couleurs, il 
est recommandé de conserver les hachures prédéfinies telles quelles et de les utiliser plutôt 
comme point de départ pour créer de nouvelles hachures. Les paramètres d’une hachure sont dé-
crits dans le Tableau 3.
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Tableau 3. Propriétés d’une hachure

Propriété Signification

Espacement Spécifie l’espacement entre deux lignes de hachure.

Angle Spécifie l’angle des lignes de hachure par rapport à l’axe horizontal. Vous pou-
vez également utiliser la miniature en dessous pour spécifier un angle multiple
de 45 degrés.

Type de ligne Indique l’utilisation d’une ligne simple ou de lignes croisées ou triples comme 
motif de hachure.

Couleur de ligne Permet de sélectionner la couleur de la ligne de hachure dans la liste dérou-
lante.

Couleur d’arrière-
plan

Si l’option est cochée, une couleur de remplissage est ajoutée derrière les 
lignes qui forment les hachures.

Créer de nouvelles hachures

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez créer ou modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Hachures pour ouvrir la page corres-
pondante (Figure 25, page 16).

 4) Modifiez les options des lignes qui constituent les hachures. Un aperçu est disponible à 
droite de la boîte de dialogue. Voyez le Tableau 3 pour les informations sur ces options.

 5) Cliquez sur le bouton Ajouter pour ouvrir la boîte de dialogue Nom. Saisissez le nom du 
nouveau type de hachures puis cliquez sur OK pour refermer la boîte de dialogue.

 6) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue Remplis-
sage.

Modifier des hachures

 1) Sélectionnez l’objet qui doit contenir le bitmap que vous souhaitez créer ou modifier.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Remplissage et cliquez sur le bouton Hachures pour ouvrir la page corres-
pondante (Figure 25, page 16).

 4) Sélectionnez le type de hachures que vous avez créé et ajouté à celles qui sont affichées 
dans la boîte de dialogue Remplissage.

 5) Modifiez les options des lignes qui constituent les hachures. Un aperçu est disponible à 
droite de la boîte de dialogue. Voyez le Tableau 3 pour les informations sur ces options.

 6) Cliquez sur le bouton Modifier pour enregistrer les changements. Aucune confirmation ne 
vous est demandée avant l’enregistrement.
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 7) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue Remplis-
sage.

Supprimer des hachures

 1) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 2) Ouvrez l’onglet Remplissage et cliquez sur le bouton Hachures pour ouvrir la page corres-
pondante (Figure 25, page 16).

 3) Faites un clic droit sur le type de hachures que vous voulez supprimer et choisissez Suppri-
mer dans le menu contextuel. Confirmez en cliquant sur Oui dans la boîte de dialogue qui 
s’ouvre alors.

 4) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les modifica-
tions.

Remarque

Il est recommandé de ne supprimer que des hachures que vous avez créées. Supprimer 
des hachures fournies avec LibreOffice peut provoquer des problèmes dans les documents 
qui utilisent une de celles-ci.

Ombre

Ombres par défaut

Vous pouvez appliquer rapidement une ombre à l’objet sélectionné en utilisant l’icône Ombre ( ) 
de la barre d’outils Ligne et remplissage. Cependant, l’ombre appliquée ne sera que celle définie 
par défaut.

Formater les ombres

Pour bénéficier de plus d’options, utilisez l’onglet Ombre de la boîte de dialogue Remplissage (Fi-
gure 33).

Figure 33 : L’onglet Ombre de la boîte de dialogue Remplissage
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 1) Sélectionnez l’objet auquel vous souhaitez ajouter une ombre.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Ombre (Figure 33).

 4) Cochez l’option Utiliser l’ombre pour appliquer l’ombre à l’objet et rendre les autres options 
accessibles.

 5) Sous cette option, cliquez sur un des neuf points du rectangle pour sélectionner la direction 
de l’ombre projetée par rapport à l’objet.

 6) Dans l’option Couleur, cliquez sur le bouton pour ouvrir une palette où vous pourrez choisir 
la couleur de l’ombre.

 7) Dans le champ Distance, saisissez l’espacement entre l’objet et son ombre.

 8) Dans le champ Transparence, saisissez la transparence de l’ombre en pourcentage (0 % : 
aucune transparence ; 100 % ombre totalement transparente).

 9) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les modifica-
tions.

Transparence

La transparence s’applique au remplissage des objets ainsi qu’aux ombres et aux lignes.

• Pour appliquer une transparence aux lignes, voyez « Formater les lignes », page 1.

• Pour appliquer une transparence aux ombres, voyez « Formater les ombres », page 27.

Pour régler la transparence de l’objet sélectionné, utilisez l’onglet Transparence de la boîte de dia-
logue Remplissage.

 1) Sélectionnez l’objet auquel vous souhaitez appliquer une transparence.

 2) Choisissez Remplissage dans le menu Format ou le menu contextuel, ou cliquez sur l’icône
Remplissage ( ) de la barre d’outils Ligne et remplissage, pour ouvrir la boîte de dialogue 
Remplissage.

 3) Ouvrez l’onglet Transparence (Figure 34).

 4) Pour appliquer une transparence uniforme, cochez l’option Transparence et saisissez le 
pourcentage de transparence dans le champ adjacent (0 % : aucune transparence ; 100 % 
ombre totalement transparente).

 5) Pour créer un gradient de transparence tel que celle-ci varie peu à peu,

– cochez l’option Dégradé et choisissez le type de dégradé dans la liste déroulante Type 
(Linéaire, Axial, Radial, Ellipsoïde, Quadratique ou Carré) ;

– définissez les options pour le type de dégradé choisi en vous rapportant au Tableau 4 
pour leurs descriptions. Les paramètres accessibles dépendent du type de dégradé de 
transparence sélectionné.

 6) Cliquez sur OK pour fermer la boîte de dialogue Remplissage et enregistrer les modifica-
tions.
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Figure 34 : L’onglet Transparence de la boîte de dialogue Remplissage

Tableau 4 : Propriétés du dégradé

Propriété Signification

Centre X, 
Centre Y

Pour les types Radial, Ellipsoïde, Carré et Quadratique, positionne le centre du 
dégradé sur l’axe X, en pourcentage de la largeur de l’objet.

Angle Pour les types de dégradés Linéaire, Axial, Ellipsoïde et Carré, spécifie l’angle 
de l’axe du dégradé par rapport à l’axe horizontal.

Bordure Spécifie le pourcentage de l’axe du dégradé à partir duquel le dégradé com-
mence (0 % : au début de l’axe ; 100 % : à la fin de l’axe).

Valeur initiale Indique la transparence initiale du dégradé. 0 % pour totalement opaque, 100 % 
pour totalement transparent.

Valeur finale Indique la transparence finale du dégradé. 0 % pour totalement opaque, 100 % 
pour totalement transparent.

Contrôle interactif de la transparence d’un objet

Vous pouvez également modifier la transparence en dégradé d’un objet avec la souris.

 1) Sélectionnez un objet qui a reçu un dégradé de transparence.

 2) Ouvrez la palette Transformations dans la barre d’outils Standard ou Ligne et remplissage 
(Figure 29, page 21) et cliquez sur l’icône Outil transparence interactif ( ). Vous pouvez 
aussi sélectionner Forme > Transformations > Outil transparence dans la barre de menu.

! Attention

Cette modification n’est possible qu’avec des objets de type courbe. Faites un clic droit sur 
l’objet et choisissez Convertir > En courbe si nécessaire.

 3) L’axe du dégradé apparaît en pointillés avec, à chacune de ses extrémités, un carré de noir 
à blanc selon la transparence (Figure 35).
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Figure 35 : L’outil transparence interactif en action

 4) Vous pouvez alors déplacer chacun de ses points pour obtenir le dégradé que vous souhai-
tez. Les valeurs des propriétés de l’onglet Transparence de la boîte de dialogue Remplis-
sage sont mises à jour. Il n’est pas possible de déplacer le point de départ de l’axe d’un dé-
gradé de transparence de type Axial.

Utiliser les styles

Remarque

Dans LibreOffice Draw, seuls les styles d’objets de dessin sont disponibles la boîte de dia-
logue Styles pour objets graphiques et dans l’onglet Styles du volet latéral.

Supposez que vous vouliez appliquer le même remplissage et la même largeur de bordure et de 
ligne à un ensemble d’objets. Cette procédure répétitive peut être simplifiée par l’utilisation des 
styles. Cette fonctionnalité vous permet de définir un format modèle (un style) et de l’appliquer à 
plusieurs objets. Pour plus d’informations sur les styles, voir le Chapitre 6, Introduction aux styles, 
du Guide Writer.

Styles liés

Les styles d’image permettent l’héritage. En d’autres termes, un style peut être lié à un autre style 
(parent) afin d’hériter de ses attributs de formatage. Vous pouvez utiliser cette fonctionnalité pour 
créer des familles de styles.

Par exemple, si vous avez besoin de plusieurs rectangles qui ne diffèrent que par leur couleur de 
remplissage, la meilleure façon de procéder est de définir un style générique pour la forme rec-
tangle qui définit les bordures, le type de remplissage, la police, etc. Puis créez des styles liés à ce
premier style, qui ne diffèrent que par la couleur de remplissage. Ainsi, si vous n’avez besoin de 
modifier que l’épaisseur de la bordure, vous pouvez ne le faire que dans le style parent, et les 
autres styles liés vont changer en conséquence.

Remarque

Quand des styles sont liés, changer une couleur change celle-ci dans tous les styles liés. 
C’est parfois exactement ce que vous voulez, parfois vous ne souhaiterez pas appliquer les 
changements à tous les styles liés. Cela vaut la peine d’y réfléchir avant.

Créer des nouveaux styles

Après création, le nouveau style apparaîtra dans les listes Tous les styles et Styles personnalisés 
de l’onglet Styles du volet latéral. Quand il aura été appliqué à un objet, il apparaîtra aussi dans la 
liste Styles appliqués.
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Avec l’onglet Styles

 1) Cliquez sur l’icône Styles ( ) du volet latéral pour ouvrir l’onglet correspondant (Figure 36)

Figure 36 : L’onglet Styles du volet latéral

 2) Sélectionnez, si vous le souhaitez, le style à partir duquel vous voulez créer un nouveau 
style.

 3) Faites un clic droit et choisissez Nouveau dans le menu contextuel pour ouvrir la boîte de 
dialogue Styles pour objets graphiques (Figure 37).

Figure 37 : L’onglet Gestionnaire de la boîte de dialogue Styles pour objets graphiques

 4) Attribuez au nouveau style un nom significatif.

 5) Si vous aviez sélectionné un style, vous allez lier le nouveau style à ce style de départ. Si 
vous n’avez pas sélectionné de style, le nouveau style sera lié au style Standard. Vous pou-
vez en choisir un autre dans la liste déroulante Hérité de si vous souhaitez que votre style 
hérite de celui-ci.

 6) Utilisez les différents onglets de la boîte de dialogue Styles pour objets graphiques afin de 
définir le format du nouveau style.

– Gestionnaire contient un résumé du style et sa position dans la hiérarchie.
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– Police, Effets de caractère, Retraits et espacement et Tabulations définissent les proprié-
tés du texte inséré dans une zone de texte ou un objet graphique.

– Cotation permet de définir le style des lignes de cote.

– Texte, Animation de texte, Connecteur, Ligne, Remplissage, Ombrage, Mise en évidence 
et Transparence déterminent le formatage de l’objet.

 7) Cliquez sur OK pour enregistrer le nouveau style et refermer la boîte de dialogue Styles pour
objets graphiques.

À partir d’un objet sélectionné

Vous pouvez créer un nouveau style à partir d’un objet déjà formaté, qui peut être un texte ou un 
objet graphique :

 1) Sélectionnez l’objet que vous voulez utiliser ou créez-en un nouveau.

 2) Utilisez les outils de la barre d’outils Ligne et remplissage (Figure 1, page 1) pour apporter 
les modifications souhaitées à l’objet.

 3) Sélectionnez Format > Styles > Nouveau style à partir de la sélection dans la barre de 
menu ou cliquez sur l’icône Nouveau style à partir de la sélection ( ) en haut à droite du 
volet latéral.

 4) Dans la boîte de dialogue Créer un style qui s’ouvre (Figure 38), saisissez le nom du nou-
veau style. La liste affiche les styles personnalisés disponibles.

 5) Cliquez sur OK pour enregistrer le nouveau style.

Figure 38 : La boîte de dialogue Créer un style

Modifier ou éditer les styles

Remarque

Il est recommandé de ne modifier ou éditer que des styles que vous avez créés. Modifier ou 
éditer des styles fournis avec LibreOffice peut provoquer des problèmes dans les docu-
ments qui utilisent un de ceux-ci.

 1) Sélectionnez un objet utilisant le style que vous voulez modifier.
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 2) Ouvrez la boîte de dialogue Styles pour objets graphiques (Figure 37) en sélectionnant Édi-
ter le style dans le menu Format > Styles ou dans le menu contextuel, ou en faisant un clic 
droit sur le style de l’objet dans l’onglet Styles du volet latéral et en choisissant Modifier 
dans le menu contextuel.

 3) Utilisez les différents onglets de la boîte de dialogue Styles pour objets graphiques pour défi-
nir le format du nouveau style.

– Gestionnaire contient un résumé du style et sa position dans la hiérarchie.

– Police, Effets de caractère, Retraits et espacement et Tabulations définissent les proprié-
tés du texte inséré dans une zone de texte ou un objet graphique.

– Cotation permet de définir le style des lignes de cote.

– Texte, Animation de texte, Connecteur, Ligne, Remplissage, Ombrage, Mise en évidence 
et Transparence déterminent le formatage de l’objet.

 4) Cliquez sur OK pour enregistrer le nouveau style et refermer la boîte de dialogue Styles pour
objets graphiques.

Éditer des styles liés

Si un objet de votre document utilise des styles liés, vous pouvez les éditer en utilisant la boîte de 
dialogue Styles pour objets graphiques de la façon suivante :

 1) Sélectionnez un objet utilisant le style que vous voulez modifier.

 2) Ouvrez la boîte de dialogue Styles pour objets graphiques (Figure 37) en sélectionnant Édi-
ter le style dans le menu Format > Styles ou dans le menu contextuel.

 3) Ouvrez l’onglet Gestionnaire de la boîte de dialogue Styles pour objets graphiques.

 4) Vérifiez que le nom du style indiqué dans le champ Hérité de est bien le style lié que vous 
souhaitez modifier.

 a) Si le style lié n’est pas celui que vous voulez éditer, cliquez sur le bouton Éditer le style à
droite du champ Hérité de jusqu’à ce que le nom du style lié soit affiché. Utilisez les divers
onglets de la boîte de dialogue Styles pour objets graphiques pour éditer le style.

 b) Quand le style lié est celui que vous voulez éditer, cliquez sur le bouton Éditer le style à 
droite du champ Hérité de puis utilisez les divers onglets de la boîte de dialogue Styles 
pour objets graphiques pour le modifier.

 5) Cliquez sur OK quand vous avez terminé pour enregistrer vos modifications et refermer la 
boîte de dialogue Styles pour objets graphiques.

Remarque

Mettre à jour des styles liés qui font partie de l’installation par défaut de LibreOffice peut po-
ser des problèmes dans d’autres documents qui utilisent les styles par défaut de LibreOffice.

Mettre à jour des styles

Pour mettre à jour un style d’image à partir des modifications apportées à un objet :

 1) Sélectionnez un objet formaté avec le style que vous désirez modifier.
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 2) Utilisez les outils de formatage de ligne (page 1) et de remplissage (page 9) pour apporter 
les changements voulus à l’objet.

 3) Utilisez une des méthodes suivantes pour mettre à jour le style avec le formatage appliqué à 
l’objet :

– Cliquez sur l’icône Actualiser le style ( ) qui se trouve en haut à droite du volet latéral.

– Sélectionnez Format > Styles > Mettre à jour le style sélectionné dans la barre de 
menu.

Remarque

Aucune confirmation n’est demandée quand vous mettez un style à jour de cette façon. 
Faites bien attention de ne mettre à jour que des styles que vous avez créés. Le faire avec 
des styles qui font partie de l’installation par défaut de LibreOffice peut poser des problèmes
dans d’autres documents qui les utilisent.

Appliquer des styles

Vous pouvez appliquer un style d’image grâce à l’onglet Styles du volet latéral de la façon sui-
vante :

 1) Sélectionnez l’objet auquel vous voulez appliquer un style.

 2) Pour afficher la liste des styles disponibles, cliquez sur l’icône Styles ( ) dans la barre 
d’outils Ligne et remplissage (Figure 1, page 1) ou dans le volet latéral (Figure 36, page 31).

 3) Faites un double clic sur le nom du style que vous voulez appliquer à l’objet.

Astuce

En bas de l’onglet Styles se trouve une liste déroulante. Vous pouvez choisir d’afficher tous 
les styles ou seulement des groupes de styles comme les Styles appliqués ou les Styles 
personnalisés.

Supprimer des styles

Vous ne pouvez pas supprimer un style prédéfini de LibreOffice, même si vous ne l’avez pas utili-
sé. Vous ne pouvez supprimer que les styles personnalisés. Cependant, avant de le faire, vérifiez 
que le style n’est pas utilisé. S’il est utilisé, remplacez-le par un style de substitution. Pour voir 
quels styles sont actuellement utilisés, sélectionnez Styles appliqués dans la liste déroulante en 
bas de l’onglet Styles du volet latéral.

 1) Pour afficher la liste des styles disponibles, cliquez sur l’icône Styles ( ) dans la barre 
d’outils Ligne et remplissage (Figure 1, page 1) ou dans le volet latéral (Figure 36, page 31).

 2) Sélectionnez Styles appliqués ou Styles personnalisés dans la liste déroulante en bas de 
l’onglet Styles du volet latéral pour afficher les styles utilisés.

 3) Faites un clic droit sur le nom du style que vous voulez supprimer et sélectionnez Effacer 
dans le menu contextuel.

 4) Si le style est actuellement utilisé, un message d’avertissement apparaît. Cliquez sur Oui sur
supprimer le style. S’il n’est pas utilisé, aucune confirmation n’est demandée.
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Appliquer des effets spéciaux

Tout comme les actions de base que sont le déplacement et le changement de dimensions, un cer-
tain nombre d’effets spéciaux peuvent être appliqués à un objet dans Draw. Plusieurs d’entre eux 
sont disponibles dans la barre d’outils Transformations (Figure 39) ainsi que dans la palette Trans-
formations (Figure 29, page21) qui s’ouvre en cliquant sur  à droite de l’icône Transformations (

3) des barres d’outils Standard ou Ligne et remplissage. Si cette barre d’outils n’est pas visible, 
sélectionnez Affichage > Barre d’outils > Transformations dans la barre de menu ou détachez 
la palette Transformations.

Rotation Retourner En corps de révolution 3D

Positionner sur le cercle 
(en perspective)

Positionner sur le cercle 
(incliner)

Déformer

Transparence interactive Dégradé interactif

Figure 39 : La barre d’outils Transformations

Les outils disponibles dans la barre d’outils Transformations sont décrits dans les sections sui-
vantes, sauf l’outil Rotation 3D qui est présenté au chapitre 7, Manipuler des objets 3D.

Faire pivoter les objets

La rotation d’un objet peut être effectuée manuellement, grâce à une boîte de dialogue ou au volet 
latéral.

Rotation manuelle

 1) Cliquez sur l’objet que vous voulez faire tourner pour faire apparaître les poignées de sélec-
tion.

 2) Pour placer l’objet en mode rotation, utilisez une des méthodes suivantes :

– cliquez de nouveau sur l’objet ;

– cliquez sur l’outil Rotation ( ) dans la palette ou la barre d’outils Transformations (voir 
page 35).

Figure 40 : Rotation manuelle d’un objet

3 à l’ouverture, mais elle est remplacée par l’icône du dernier outil utilisé
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Les poignées de sélection changent de forme et de couleur pour indiquer le passage au 
mode rotation (Figure 40).

 3) Si nécessaire, cliquez et tirez le point central pour déplacer le centre de la rotation que vous 
allez effectuer. Celui-ci est, par défaut, situé au centre de la boîte de sélection, ce qui 
convient très souvent, mais, dans certains cas, vous pourrez avoir envie de faire tourner l’ob-
jet autour d’un sommet ou même d’un point extérieur à l’objet.

 4) Placez le pointeur de la souris au-dessus de la poignée d’un des sommets de la boîte de sé-
lection. Sa forme change (Figure 40). Seules ces quatre poignées des coins permettent une 
rotation.

 5) Cliquez et tirez la souris dans la direction de la rotation souhaitée. L’angle de rotation est vi-
sible dans la zone d’information de la barre d’état.

 6) Relâchez le bouton de la souris quand vous avez atteint la position souhaitée.

Pour limiter l’angle de rotation à un multiple de 15°, appuyez sur la touche Maj et maintenez l’ap-
pui pendant la rotation de l’objet. Cela se révèle très pratique pour effectuer une rotation de 90° et 
faire passer une figure de l’orientation portrait à l’orientation paysage.

Avec le volet latéral

Pour faire pivoter un objet grâce à la section Position et taille de l’onglet Propriétés du volet laté-
ral :

 1) Cliquez sur l’objet que vous voulez faire tourner pour faire apparaître les poignées de sélec-
tion.

 2) Ouvrez l’onglet Propriétés en cliquant sur son icône ( ) à droite de la fenêtre puis la section
Position et taille en cliquant sur  à gauche de son titre (Figure 41).

Figure 41 : la section Position et taille de l’onglet Propriétés du volet latéral
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 3) Cliquez sur la roue sous Rotation et faites-la tourner. L’objet sélectionné suit les mouvements
de la roue. Vous pouvez aussi saisir une valeur dans le champ à sa droite ou sélectionner un
angle prédéfini dans la liste déroulante associée.

 4) Cliquez hors de l’objet quand vous avez obtenu la position souhaitée pour la fixer.

Avec la boîte de dialogue Position et taille

En plus des deux méthodes précédentes, vous pouvez utiliser l’onglet Rotation de la boîte de dia-
logue Position et taille (Figure 42) pour un contrôle plus précis de la rotation de l’objet.

 1) Cliquez sur l’objet que vous voulez faire tourner pour faire apparaître les poignées de sélec-
tion.

 2) Ouvrez la boîte de dialogue Position et taille

– en appuyant sur F4,

– en sélectionnant Position et taille dans le menu Format ou le menu contextuel de l’objet

– en cliquant sur son icône ( ) dans la barre d’outils Standard ou Ligne et remplissage.

 3) Ouvrez l’onglet Rotation.

 4) Dans la section Point de pivot, saisissez, dans les champs de saisie Position X et Position 
Y, les coordonnées du centre de rotation par rapport au coin supérieur gauche de la feuille.

Vous pouvez aussi choisir une position par rapport à la boîte de sélection de l’objet dans le 
schéma Paramètres par défaut. La position par défaut se trouve au centre de la boîte de sé-
lection.

Figure 42 : L’onglet Rotation de la boîte de dialogue Position et taille

 5) Dans la section Angle de rotation, saisissez une valeur dans le champ de saisie Angle ou 
cliquez sur la roue à droite et tirez la souris pour obtenir l’angle voulu. Le champ Angle est 
mis à jour pour suivre les mouvements de la roue.

 6) Cliquez sur OK pour enregistrer les modifications, fermer la boîte de dialogue et faire pivoter 
l’objet.
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Retourner des objets

Retournement rapide

La méthode la plus simple pour retourner un objet horizontalement ou verticalement est la sui-
vante :

 1) Sélectionnez l’objet à retourner pour que les poignées de sélection soient visibles.

 2) Utilisez l’une des méthodes suivantes pour retourner l’objet horizontalement ou verticale-
ment :

– Faites un clic droit et choisissez Retourner > Verticalement ou Retourner > Horizonta-
lement dans le menu contextuel. Vous pouvez trouver également ces commandes dans 
le menu Forme.

– Dans la section Position et taille de l’onglet Propriétés du volet latéral (Figure 41, page
36), cliquez sur les icônes Retourner l’objet sélectionné verticalement ( ) ou hori-
zontalement ( ).

– Cliquez sur les icônes Verticalement ( ) ou Horizontalement ( ) dans la barre d’ou-
tils Ligne et remplissage (Figure 1, page 1).

Avec l’outil Retourner

L’outil Retourner de la barre d’outils (Figure 39, page 35) ou de la palette (Figure 29, page 21) 
Transformations peut aussi être utilisé. Cet outil vous permet de modifier la position et l’angle de 
l’axe de symétrie (Figure 43  ➁ ).

 1) Cliquez sur l’objet graphique à retourner. Les poignées de sélection apparaissent.

 2) Cliquez sur l’icône Retourner ( ) dans la barre d’outils ou la palette Transformations. L’axe 
de symétrie apparaît sous la forme d’une ligne de pointillés au milieu de l’objet (Figure 
43 ➀). L’objet sera retourné autour de cet axe.

 3) Cliquez et tirez avec la souris une ou les deux extrémités pour déterminer l’orientation de 
l’axe de symétrie (Figure 43 ➁) ou l’axe lui-même pour le déplacer sans changer l’orienta-
tion.

 4) Placez le curseur de la souris au-dessus d’une poignée de sélection de l’objet afin que sa 
forme change.

 5) Cliquez et faites glisser le curseur de l’autre côté de l’axe de symétrie. Une image fantôme 
de l’objet retourné apparaît (Figure 43 ➂).

 6) Relâchez le bouton de la souris et l’objet retourné apparaîtra (Figure 43 ➃).

Remarque

Si vous gardez appuyée la touche Maj durant le déplacement de l’axe de symétrie, l’angle 
de cet axe est limité aux multiples de 45 degrés.
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➀ ➁

➂ ➃

Figure 43 : Utilisation de l’outil Retourner de la barre d’outils Transformations

Copies miroir

À l’heure actuelle, il n’existe aucune commande Miroir dans Draw. Cependant, l’effet peut être 
réalisé en utilisant l’outil Retourner de la façon suivante :

 1) Sélectionnez l’objet dont vous voulez réaliser une copie miroir et copiez-le dans le presse-
papiers.

 2) Collez-le sur lui-même.

 3) Sélectionnez l’outil Retourner dans la barre d’outils ou la palette Transformations.

 4) Déplacez l’axe de symétrie à l’emplacement désiré et effectuez le retournement.

 5) Si nécessaire, réalignez les deux objets avec les outils d’alignement (Aligner dans le menu 
Forme ou le menu contextuel, ou la palette Aligner ( ) de la barre d’outils Ligne et remplis-
sage).

Déformer un objet

Trois outils de la barre d’outils Transformations permettent de déplacer les coins et les bordures 
d’un objet pour le déformer.

• Déformer déforme un objet en perspective.

• Positionner sur le cercle (incliner) crée un effet pseudo-tridimensionnel.

• Positionner sur le cercle (en perspective) crée un effet pseudo-tridimensionnel.

Dans les trois cas, il peut vous être demandé si vous voulez transformer l’objet en courbe. Comme
cette étape est nécessaire, cliquez sur Oui. Vous pourrez ensuite déplacer les poignées des objets
pour produire l’effet désiré. Des exemples d’utilisations de ces outils sont proposés dans les fi-
gures suivantes.
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Déformer

Sélectionnez l’objet à déformer et cliquez sur l’icône Déformer ( ) dans la barre d’outils (Figure 
39, page 35) ou de la palette (Figure 29, page 21) Transformations. Après avoir converti l’objet en 
courbe comme demandé, cliquez et faites glisser une poignée de sélection pour déformer l’objet 
(Figure 44). L’effet sera différent selon la poignée sélectionnée.

En utilisant une poi-
gnée de coin.

En utilisant une poi-
gnée au milieu d’un 
côté vertical.

En utilisant une poi-
gnée au milieu d’un 
côté horizontal.

Figure 44 : Déformer un objet

Positionner sur le cercle (en perspective)

Sélectionnez l’objet à déformer et cliquez sur l’icône Positionner sur le cercle (en perspective) (
). Après avoir converti l’objet en courbe, cliquez et faites glisser une poignée de sélection pour 

déformer l’objet (Figure 45).

Figure 45 : Positionner un objet sur un cercle en perspective

Positionner sur le cercle (incliner)

Sélectionnez l’objet à déformer et cliquez sur l’icône Positionner sur le cercle (incliner) ( ). 
Après avoir converti l’objet en courbe, cliquez et faites glisser une poignée de sélection pour défor-
mer l’objet (Figure 46).
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Figure 46 : Positionner un objet sur un cercle avec inclinaison

Remarque

Transformer un objet en courbe est une opération qui ne peut être inversée qu’avec la fonc-
tion Annuler (Édition > Annuler dans la barre de menu ou icône Annuler  dans la barre 
d’outils Standard).

Dégradés dynamiques

Il est possible de contrôler des gradients de transparence de la même façon que les dégradés de 
couleurs et les deux types peuvent être utilisés simultanément. Avec un gradient de transparence, 
le degré de transparence du remplissage d’un objet varie entre opaque et totalement transparent 
dans une direction donnée. Dans un dégradé de couleurs, le remplissage passe d’une couleur à 
une autre, mais la transparence reste la même.

Deux icônes de la barre d’outils Transformations (Figure 39, page 35) permettent de contrôler de 
façon dynamique, l’un les gradients de transparence ( ), l’autre les dégradés de couleurs ( ).

Même si vous n’avez pas affecté de transparence à un objet avec un remplissage de couleur, vous
pouvez contrôler la transparence en cliquant sur l’icône de l’Outil transparence interactive. Cela 
définit un gradient de transparence et une ligne en tirets qui joint deux carrés apparaît sur l’objet. 
Déplacez les deux carrés pour modifier le gradient. Vous pouvez en définir la direction (verticale, 
horizontale ou inclinée à un angle donné) et le point où la transparence commence.

Un dégradé de couleurs normal est défini de la même façon. Sélectionnez un objet, choisissez un 
dégradé dans l’onglet Dégradé de la boîte de dialogue Remplissage (Figure 22, page 13). L’Outil 
dégradé interactif est alors accessible dans la barre d’outils Transformations. Quand vous cliquez
sur celui-ci, une ligne en tirets reliant deux carrés apparaît sur l’objet, exactement comme pour un 
gradient de transparence.

Dans les deux cas, cliquez hors de l’objet pour confirmer le remplissage.

Dans l’exemple de la Figure 47, le rectangle est rempli par un dégradé linéaire et a reçu un gra-
dient de transparence radiale de 100 % au centre à 0 % à la périphérie. Le gradient de transpa-
rence peut être ajusté dynamiquement en déplaçant le carré blanc pour modifier le centre et le car-
ré noir pour modifier la bordure (début du gradient).
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Figure 47 : Exemple de gradient dynamique

Remarque

L’effet du déplacement des carrés est différent selon le type de gradient. Par exemple, pour 
un gradient linéaire, les carrés de début et de fin sont toujours situés de chaque côté du 
centre de l’objet.
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